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The MPR-9800 is equipped with normally open PV relays. The controller will sample the PV current input at five minute intervals by energizing these relays and will search for current flow. (Pre-set at the factory to 5 minutes - window 406). During this sample time, the MPR-9800 will monitor the PV current input. If there is any power input detected from the PV arrays, the normally open relays will remain energized and the controller will operate the high voltage disconnect (HVD) and reconnect to charge the batteries. If there is no power detected from the arrays after the reconnect of the PV arrays, the controller will de-energize the PV relays and will then begin the 5 minute sampling described above. This feature is implemented so that the arrays are not energized during the evening hours or periods of sunless hours.

As a control method, if the initial start up of the MPR9800 does not have or detect any PV current input, it will de-energize the normally open PV relays. The controller will begin its programmed 5-minute sampling until PV current is detected.

To ensure that the PV relays remain energized on start up, connect the PV arrays by turning on the PV circuit breakers before connecting the main battery disconnect or wait for the 10 minute timing sequence to begin.

INTRODUCTION

The information contained in this manual will provide the user with the knowledge necessary to properly operate and maintain the MPR-9800 controller. It is recommended that the user completely and fully understand all portions of this manual prior to the installation and usage of the MPR 9800 Controller.

The MPR-9800 combines versatility with ease of use and is manufactured to industrial and military specifications to ensure years of reliable operation for any photovoltaic power system.

The design of the MPR-9800 to provides a reliable, accurate and user friendly microcomputer controller.

1. Description

1.1. General Description

The MPR-9800 microprocessor based photovoltaic controller provides the user with the highest accuracy of regulation ranging from medium to large size (35A to 200A) power systems.  Microprocessor controlled circuitry allows the user to quickly configure the system to their requirements and easily change the controller’s set points to accommodate a wide variety of battery types and load control.

The MPR-9800 controller is configured from the factory to meet various system voltages and power requirements. The controller is available in nominal system voltages of, 12V, 24V and 48V in negative or positive ground, as well as PV amperages of 35A, 60A, 120A and 200A. The 60A, 120A and 200A controllers are configured with 2 PV channels for staged sub-array charging.

1.2. Functions - Standard MPR9800 Controller Functions
a. “Energy Based Battery Management”: Charge algorithm with multi-staged PV arrays, generator hybrid's, LED indicators, selectable ON or OFF battery equalization and temperature compensation of HVD and LVD.

b. Storage battery discharge management with LED indicators, automatic scrolling LCD of the systems voltages, PV amps, load amps, temperatures, amp hours of the battery, PV input and load output, state of charge, load discharge hours, relay states indication of pV1, pV2, Load, HVA, LVA and GEN.

c. System status indication by LED's, LCD screen and 232 port.

d. Nominal voltages of 12, 24, 48, volts.

e. Alarms for high and low battery monitoring with SPDT relays rated at 5A with LED indication of alarm status.

f. Negative or positive ground.

g. Remote battery temperature sensor for set point temperature correction with fail safe to 25°C.

h. Controller temperature sensor.

i. LCD display metering with adjustable controller set points via Portable PC Computer or Telephone modem.

j. Protected from reverse polarity and/or wrong voltage settings.

k. Lightning, surge, and static protection.

l. Accumulation and display of the PV and Load Amp-Hours.

m. Self-correcting software with password access and watchdog fault restart.

n. Circuit breaker disconnects for PV (source) load control, arrays and load.

1.3. Model Numbering Code

The MPR-9800 has a wide variety of hardware options available to accommodate any field configuration desired.  The following table summarizes the numbering code for the units from the factory.
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An example configuration from the factory is MPR-9800-60A/12V/35A/N-L. (NS indicates a non-standard value)
  #1  #2  #3  4 5 6 7

MPR-9800-XXV/XXXA/XXXA/X X X X
#1.
XXA - Nominal System Voltage: 12V, 24V or 48V

#2.
XXV - Maximum Array Output Current: 35A, 60A, 120 or 200 

#3.
XXXA - Maximum Array Input Current: 35A,60A,100A

#4.
X - Negative or Positive Ground: N or P

#5.
X - Modem Option:

M = With

Blank = Without

Example: MPR-9800-24V/2X60A/35A/N
MPR-9800 with a 12 Volts system, a 120Amp Array input Current, Load output current of 35 Amps and Negative Ground

1.4. Options

a.
Modem

1.5.     DATA LOGGING - DATA ACQUISITION SYSTEM
On some MPR9800 units (firmware version 6+), history Data Logging is provided for the parameters listed below.

1. Daily averages and maximum and minimum – PV500
DATA WILL BE TAKEN and logged DAILY AT END OF DAY SETTING- WINDOW #210, Factory SETTING IS AT MIDNIGHT (OR 00:00) EACH DAY
2. 1, 5, 15, 30 or 60 minute interval averages 

INTERVAL SOFTWARE DATA LOGGING (not SUPPORTED ON SOME MODELS)

The Interval software data logging will record the following parameters at intervals specified by the Data Logging Mins parameter (See the Factory screen for more information about setting the Data Logging Minutes parameter).
HEADING of file- Log Data - Unit SN (serial number)

Column Headings;
Month

Day

Hour

Minute

Average battery volts

Average PV amps

Average load amps

Average battery temperature

Average controller temperature

Generator hours

HVA status

LVA status

2. Theory Of Controller Operation

2.1. General Overview

System voltage regulation is accomplished by using the microcomputer control circuit and relays to switch the power to and from the battery to maintain the system voltage within a proper range.

The MPR-9800 has eight standard channels - HVD1, LVD, HVD2, HVA, LVA, GEN and the battery voltage sense input and battery temperature sensor.

2.2. Power Input Control and Monitor

2.2.1. Battery Charging Modes

The MPR-9800 uses either a conventional voltage controlled ON/OFF series charge algorithm or the charging algorithm, EBBM (Energy Based Battery Management). This is the charge algorithm programmed from the factory. EBBM one or the methods of charging a PV system's batteries. The algorithm incorporates bulk charging with a finishing pulse charge mode. Using these two charge modes, the controller can be accurately set to charge batteries from various battery manufacturers so the manufacturers needed percent of over charge can be accurately accomplished without damaging the batteries by excessive over charge1 (Sandia Report).

2.2.2. High Voltage Disconnect & High Voltage Alarm

When the PV arrays charge the batteries, the charging will be switched to pulse mode until the batteries are sufficiently charged to your battery type and battery manufacturers recommended percentage. This percent of over charge is programmed at the factory and can be easily change in the field. At this point the charging is interrupted. When the battery voltage falls to the AH reset voltage the charging algorithm engages again.  If for any reason this HVD does not occur, the HVA will engage to alert of an over voltage problem.

2.2.3. Input Current Monitoring

Input current is sensed through a PV shunt and shown as the number of amps via the LCD with Amp-Hours counted and displayed.

See LCD section 6.1 window 2 and 3.

2.2.4. HVD2 and Staged Array Control

Staged sub arrays are accomplished with an additional mercury displacement relay.  The controller uses both arrays to bulk charge the batteries. The HVD2 then pulses to allow taper charging of the battery.

2.2.5. Generator

There is a one-form C-5 amp relay (2 wire start) provided for a generator start/stop with voltage control set points which can be field adjusted. See section 3.8.5.

2.2.6. High Set Point - Temperature Compensation

The high temperature compensation will cause the HVD1, HVD2 and Generator set points to adjust by -5mV/°C/cell (25°C ref.)

Note: Temperature Compensation has three selections.

1) Disabled- no temperature compensation.

2) Standard Range- temperature compensation will be in effect for the entire temperature operating range of the controller/batteries.

3) T>ORange- At temperatures below 0°C, temperature compensation will be in effect but the compensated set points will remain at the 0°C values (important with VRLA type batteries).

2.2.7. Battery Equalization

Automatic or manual battery equalization can be enabled or disabled by the user, via computer.

Manual/Auto and number of days between equalization can be selected, including the voltage increase above HVD to equalize.  Equalization is applied to HVD's and Generator.

Equalization, when selected will pulse the HVD1 to the programmed voltage increase above the HVD1 setting for one solar day. NOTE: In manual mode, the equalization will remain on effect until the manual mode is disabled on the status screen by pressing equalize button again.

2.3. Power Output Control and Monitor

2.3.1. Low Voltage Disconnect & Low Voltage Alarm

On the low end of the voltage discharging curve, when the load discharges the batteries to your chosen LVD, the power to the load will be interrupted. This version of software includes a load timing function, which can be enabled or disabled with time of day ON and OFF.  Prior to the LVD, the LVA will engage to alert of a low voltage problem. The MPR-9800 will also disconnect the load if the controller detects a high amperage output in the case of load failure causing excessive current draw or a short circuit in the load wiring.

An “LVD Delay” parameter is present in firmware versions PS4.00.00 and above. The LVD Delay is the number of seconds that will elapse between the detection of the LVD Disconnect condition and the deactivation of the LVD relay.

2.3.2. Output Current Monitoring

Output/Load Current is sensed by a load shunt and shown as the number of Amps via the LCD with Amp-Hours counted and displayed.

See LCD sections 6.1 windows 2 and 3.

2.3.3. Load Set Point Temperature Compensation

When low temperature compensation is set, the LVD/reconnect set points will be temperature compensated by the factor programmed. (In the same manner as the HVD). The factory setting is for no LVD temperature compensation, if required program this value in the “INSTALL” window.

2.4. Battery Condition/System Monitoring

The MPR-9800 LCD (if installed) has 6 windows that automatically scroll for viewing.

2.4.1. Information Window

Digital Solar Tech ROM version, and serial number and address number, (if the version is 4.00.00 or higher), is displayed.
2.4.2. Battery Voltage, State Of Charge and Load Duration

Battery voltage, State of charge and Hour of load available are shown on the LCD- Window 1.  Shown are the battery voltage, percent (%) of original capacity SOC and Load hours.

See section 6.1 window 5.

2.4.3. Current Monitoring

Current Monitoring is displayed on the LCD- window #2. The currents displayed are the net battery current, PV current and load current.

See Section 6.1 window 1.

2.4.4. Battery Amp Hours, PV Amp Hours and Load Amp Hours

The battery’s real time Amp Hour capacity, the PV Amp Hours “IN” and the Load Amp Hours “OUT” from the previous reset are displayed.

See section 6.1 window 2.

2.4.5. Battery and controller Temperature Monitoring

Battery and controller temperature are displayed on the LCD- window #4

See section 6.1 window 4.

2.4.6. Relay states of the Load, Array #1, Array #2, HVA,LVA and GEN. An * will appear if the relay is energized.

3. Controller Installation

Install the MPR-9800 controller in accordance with local and/or national electrical codes.

NOTE:
IF the MPR-9800 Controllers are ordered using normally closed PV relays, the controller does not contain blocking diodes. These should be installed in the array source circuits, the module(s) or the field junction boxes.

Normally “Open” PV and Load Relays are installed on these controllers. If the controller is ordered using Normally Open relays, the controller will automatically disconnect the Arrays at night. No diodes are needed.

3.1. Environment

When installed in a NEMA 4 enclosure, the MPR-9800 controller can be operated outdoors but must be shaded from the sunlight throughout the day and protected from direct water and rain exposure.

If ordered installed in a NEMA 1, the unit must be installed indoors.

NOTE:
Do not install in the same enclosure as the batteries if ordered in a NEMA 1.

Do not install where flammable liquids and gases are present.

3.2. Orientation

Because of the Mercury Displacement Relays, the MPR-9800 must be installed securely to a sturdy vertical wall or array structure and in an upright position. Keep system cables as short as possible to maintain the lowest voltage drop.  Cable entry holes in the bottom and/or side of the enclosure should either be plugged or should have waterproof strain relief cable connectors to prevent moisture intrusion.

3.3. Photovoltaic Array

Your system manual will include array tilt angles and directional facing for you photovoltaic power system. Connections between solar modules, junction boxes, switches, and the regulator must be secure. Strain relief cable connectors (where cables enter the boxes) should also be used throughout the system. Special attention must be paid to proper polarity when making electrical connections.
3.4. Batteries

The storage batteries should be located inside a building or dedicated enclosure that prevents moisture, blowing sand or dirt, and animals from disturbing them. The enclosure will also provide additional protection against electrical shock to individuals in the area.

Whenever possible, the batteries should rest a few inches above a cement floor on metal or heavy wooden risers. If a rack is used, it should be designed to support the weight of the batteries. In the case of a multi-tiered rack, space between tiers should be sufficient to allow for checking electrolyte levels and making other visual inspections. Sufficient space should also be left between racks or rows of batteries to permit service personnel to move about and exit the battery area.

3.5. Installation of Option

See Appendix and/or contact your local representative.
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MPR-9800 CONTROL WIRING

Figure #1

3.6. Installation of the Controller

**Wires to be connected - Verify that the polarity is correct! **

· Battery

· Battery sense wires - NOTE: B is ALWAYS NEGATIVE! CONNECT LAST!
· Arrays

· Loads

· Battery Temperature sensor. (May have been factory installed) Provide a hole in the enclosure for the battery sensor if not installed.

Wires which may or may not be connected – 

· Generator control wires

· HVA control wires

· LVA control wires

Turn all circuit breakers (INTERNAL DISCONNECTS) OFF in the controller.

Be sure all wires to be connected to the controller are not energized at this time.

3.7. Wiring Procedure

Be certain that the wires and polarity are connected correctly and that all loose strands of wire are in their respective terminal

Be sure that sections 3.1. 3.2, 3.3, 3.4, 3.5, 3.6, 3.7 have been completed, before beginning this next procedure.

3.7.1. Wire Connection Order

Be certain that the external array disconnect(s) (if used) and the internal array disconnect(s) are in the OFF position. See figure #2.

3.7.2. Earth Ground

The MPR-9800 has been specially designed to allow the user to install the controller with a common ground, (either negative or positive) or floating the ground, which ever the customer desires.  If a common ground is used, connect the EARTH GROUND wire from the negative side of the Battery to a GROUNDING ROD in a negative ground system -or- to the positive side of the Battery in a positive ground system.

Use a minimum of #8 AWG wire on 60 AMP units, #4 AWG wire on 60 to 200 AMP units.

To prevent ground loops, do not ground the system in 2 separate locations.

NOTE:
The Battery Common, Array Common and Load Common in the controller are connected.

Feed all wires coming into the enclosure through customer supplied watertight strain relief's (in NEMA4X) and after connections are made to the terminal blocks, tighten the strain relief's to create a seal!

3.7.3. Battery

Connect the main Battery cables using the correct polarity shown on the Connection Decal inside of the enclosure to the battery terminal block marked “BATTERY” and connect the ground to the common buss marked “GROUND BUSS”.
3.7.4. PV Array(s)

Connect the non-ground conductor of the PV Array #1 to the circuit breaker marked Array #1 in the correct polarity.  Connect Array #2, if used, to the circuit breaker marked Array #2 in the correct polarity. Connect the ground(s) to the common buss.

3.7.5. Generator

Connect the generator control wires to the "GEN" start/stop relay on the I/O PCB. Connect the Gen. power wire to the controller. This will allow the MPR-9800 to monitor the AmpHrs of input from the generator.

3.7.6. DC Loads

Connect the non-ground conductor of the LOAD to the circuit breaker marked “LOAD” in the correct polarity. Connect the ground(s) to the common buss, which contains the shunts.

*** At this time connect the wires to the Loads ***

3.7.7. Wire Connection

Connect wires at the PV array(s), Load and Generator.

3.7.8. Temperature Sensor

If not installed, connect the temperature sensor cable. Feed cable through a watertight strain relief, if a NEMA4X enclosure is used, and connect the 2 conductors to the small terminal block marked TEMP A & B.  Polarity will not matter. See figure 1, the Temperature sensor may have been factory installed. The Temperature sensor is mounted inside an isolated ring terminal and should be fastened to the battery bank. The recommended method is to place the ring terminal under one of the bolts on a battery post in the middle of a battery string.

3.7.9. Misc. Connections

Connect all other control wires, LVA, HVA, and GEN.  The terminal strip will accept conductors from #22 AWG to 16 AWG. Connect as shown on silkscreen. The GEN, HVA and LVA are one form "C" relay contacts.

Be sure these wires are inserted all the way into the terminal before tightening.

3.7.10. Connection Verification

Check all PV, Battery and Load wires for correct connections and polarity using a voltage meter.

3.7.11. Battery Connections

Connect the cables to the battery(s) in the CORRECT polarity.

*** This should be the last connection(s) made to the controller ***

3.7.12. Terminal Screws

Retighten all terminal block screws at this time, as they may be loose.  This step should be repeated after the system has operated at capacity for one week and once every few months.  This will ensure positive connections since thermal stresses will loosen these and all screws.

4. Controller Start-Up and Programming

4.1. Step 1

Switch on the battery disconnect switch or “Load Control CB” (If installed.

The “Load Control CB” will power up the controller.

Battery Voltage Sense: Using 16 AWG 2 conductor wires, run the sense wires from the battery to the controller through a strain relief on the enclosure and connect to the terminal block on the I/O PCB marked “BATT A B”.

“A” is always positive

“B” is always negative

ALWAYS INSTALL A FUSE IN THE BATTERY SENSE WIRE; ALWAYS DISCONNECT THE BATTERY SENSE WIRE BEFORE POWERING DOWN THE MPR-9800. IF NOT THE CONTROLLER WILL CYCLE. THIS CYCLING WILL NOT DAMAGE THE CONTROLLER.
4.2. Step 2

Check the LCD display for the introductory display. “MPR-9800 DST, Boulder, CO”. If not there, try disconnecting and reconnecting the battery power.

4.3. Step 3

If system parameters and set points need to be changed, (see the "Birth Certificate” that was included with the controller), program all settings by means of the computer. See section 7 for computer interface instructions.

4.4. Step 4

If external disconnects are used for the PV array(s) and Loads, Turn them ON at this time.

4.5. Step 5

Turn ON the internal PV MAIN circuit breaker and the PV Array(s) disconnect circuit breaker(s).  The Window 2 will now read the Net Amps and PV Amps (if daylight). (Only Array Amps at this time)

4.6. Step 6

Turn ON the internal Load disconnect circuit breaker.  The Window 2 will show the Net Amps going into/out of the battery, the PV Amps and the Load Amps.

4.7. Controller Shut-Down

ALWAYS DISCONNECT THE ARRAYS BEFORE THE BATTERIES!

1. Disconnect the Load external and Load disconnects. DO NOT DISCONNECT THE LOAD CONTROL CIRCUIT BREAKER AT THIS TIME.

2. Disconnect the Arrays external and internal disconnects.

3. Disconnect the battery voltage sense wires.

4. Disconnect the Load Control CB if installed, or disconnect the external battery disconnect. (Controller Power Down)

The controller is now powered down.
5. Battery Condition Indicators

5.1. LED Panel Indicators

5.1.1. Load LED

The Green LOAD LED is the Load ON/OFF indicator.  This LED will turn ON when the Load is ON and will turn OFF when either the LOAD is disconnected by the computer interface (See Section 6.6 Level 3 window 305) or when the LVD voltage set point is reached.  In the case when the LVD set point is reached, the Load and this LED will not turn ON until the reconnect voltage set point is reached. Turning OFF the Load circuit breaker will not disable the load control circuit so the LED will remain ON.

5.1.2. LVA LED

The Yellow LOW VOLTAGE ALARM LED will turn ON when the LVA set point has been reached and will turn OFF when the reconnect voltage set point has been reached.

5.1.3. HVD LED

The YELLOW ARRAYS OFF LED will turn ON when the HVD1 set point has been reached and will cycle ON/OFF during the finishing pulse charge cycle and will remain ON after the batteries have reached full charge.  This LED will turn OFF when the reconnect voltage set point is reached.

5.1.4. HVA LED

The Red HIGH VOLTAGE ALARM LED will turn ON when the HVA set point has been reached and will turn OFF when the reconnect voltage set point is reached.

5.1.5. Generator LED

The Green GENERATOR ON LED will turn ON (if the generator is enabled), when the Generator voltage "ON" set point is reached and will turn OFF when the GEN “OFF” voltage set point is reached.

5.2. Manual Control Switching

All manual control switching is accomplished with a local computer interface or with an optional "remote" Modem communication package.

6. The LCD Screen

The LCD Screen is used to view information.

6.1. LCD Screen

The screen is a 2 X 24 LCD.  In general the top line is used to display text describing the numerical or function information appearing on the lower line.  The information on the lower line changes as conditions change or functions are changing.  For instance, A standard display line contains the Text "1 Volts  %SOC LdHrs"  on the top line and the values of the voltage SOC and Load Hours on the lower line.

Each different display screen is called a WINDOW.  There are 6 WINDOWS.  The area within a WINDOW which contains a numerical value or function mode text is called a FIELD.  There are up to 2 FIELDs in a WINDOW.  Complete descriptions of each WINDOW and FIELD are contained in the following sections.  Each FIELD can contain a VALUE or a SETTING.  A VALUE is a Number; a SETTING is a text descriptor of a state.

The 6 windows will automatically scroll with a 4 second delay between each window.

	1
	Volts
	%SOC
	LdHrs

	
	53.52
	93
	45.3


In the example above, the window is 1 and the 
Bat:V, %SOC and Load hours VALUEs on the lower line are the FIELDs for this Window.

Here is an overview of the information available at each WINDOW.

It has 7 WINDOWs which are all for viewing only.  There are no settings to change. All setting changes are accomplished via computer, either locally or remotely with the modem option.  The values in these WINDOWs are updated each second. A * appears on line 2 to indicate when the average time has been reached.

WINDOW 0 - Displays the Model number, company, ROM version and serial number.

Digital Solar FW 4.00.14

Addr 123
SN:981021
WINDOW 1 - Window #1 displays the Battery volts, State Of Charge and Load hours.

	1
	Volts
	%SOC
	LdHrs

	
	53.52
	93
	45.3


WINDOW 2 - Window #2 display the Net amps into/out of the battery, PV amps and Load amps.

	2
	Amps:Bat
	PV
	Load

	
	40.0
	50.2
	10.5


WINDOW 3 - Window #3 displays the real time Amp Hour capacity of the battery, the PV Amp hours and Load Amp hours since last reset.

	3
	AHrs:Bat
	PV
	Load

	
	1000
	1490
	1341


WINDOW 4 - Window #4 displays the Temperatures of the battery and the controller.

	4
	degC:
	Bat
	Unit

	
	
	28
	31


WINDOW 5 - Window #5 displays the State of PV1, PV2, Load, HVA, LVA and GEN relays. If the relays on any of the channels are “ON” there will be an “*” below the nomenclature.

	5
	LD
	PV1
	PV2
	HVA
	LVA
	GEN

	
	*
	*
	*
	__
	__
	__


7. Communicating with the MPR-9800

COMPUTER AND MODEM OPERATION

The MPR-9800's control functions are accessible by computer, either by direct connection or by telephone modem. Using a MODEM computer cable assembly or modem option and software, the user is able to down load the controller's data and also change any set point. The following is the description of the operation.

MPR-9800 COMMUNICATIONS SOFTWARE INSTRUCTIONS
Getting Started with MPRCOM Software

MPR-9800 COMMUNICATIONS SOFTWARE INSTRUCTIONS
Getting Started with the MPR-9800 MPRCOMM Software

These instructions assume you understand the Windows operating system

Hardware and Software Requirements

To use MPRCOMM, you need the following system software and equipment:

· A Pentium-class PC, running Microsoft Windows 98/ME/NT/2000/XP.

· Color monitor capable of displaying a screen resolution of 800x600 or greater

· Printer

· To communicate locally with a MPR-9800 unit you must have a standard (straight-through wired) “modem cable”.

· An internal or external modem on your PC (for modem-connected MPR-9800s); or an Ethernet-compatible network interface (for network-connected MPR-9800s)

· START COMPUTER SO IT IS RUNNING UNDER WINDOWS

Installing MPRCOMM on a hard disk
1.
Boot up the Windows operating system.

2.
Execute the “MprComm-nnn.exe” program from the root folder of your installation CD (the “nnn” represents the numeric version number of the software installer). The MprComm-nnn.exe program is a self-extracting archive which will automatically launch the MprComm software installer.

3.
Follow the on-screen instructions to install the software. You may choose a custom drive and path for the software if you wish (default installation location is C:\MprComm).

4.
When the installation is complete, you may be prompted to restart your computer. 

5.
Execute the program via the MprComm shortcut by selecting it from the Programs menu. 

Configuring Local Communications Connection for the first time

1. Connect the modem cable to the serial port on your computer

2. Connect the other end of the cable to the DB9- RS232 port located on the MPR-9800 PCB (only if a modem/network card is not installed) or the DB9 port on the modem/network card located on the rear of the instrument panel.

3. Run the MPRCOMM by selecting the MprComm program from the Programs menu.

1. Select the menu "Tools" and click on the "Options" submenu. See Screen figure #7 and #8A through #8B. In the “General” Settings screen (Figure #8A), the “Demo Mode” setting places the software in demonstration mode. Please ensure that the Demo Mode option is unchecked for normal program operation. In the “General” tab (figure #8A), ensure that the “Direct Cable” option is selected, if you are attempting to connect to the MPR unit via a direct serial cable.

2. In figure #8B (the Modem/Network Settings screen), you may select your modem, or enter the phone number or IP address of the MPR unit (if you are connecting via the modem or Ethernet communication options). 

3. Select "OK" to accept the parameter changes. You may be asked to restart the program for the changes to take effect.

4. Click the “Connect” toolbar button to establish a connection to the MPR unit.

NOTE:
After the communication settings have been configured the first time, in the future you may simply click on the “Connect” toolbar button to connect to the MPR unit. 

Remote Modem Communications Connection
1. If an external modem is used, connect the modem to the serial port of your computer with the proper cable and connect the phone line to the modem.

2. Run the program

3. If you have already configured the software for modem communications, skip to step 4. Otherwise, select the menu "Tools" and select the "Options" submenu. Click on the “Communication” tab of the Options dialog. See figure #7 and #8B. On figure #8B, select your modem from the drop-down list. Click “OK” to save these settings. You may be asked to restart the program for the changes to take effect.

4. From the “General” tab of the Options dialog, select “Modem” as your default connection method. Close the Options dialog, then click the “Connect” button on the toolbar. In the dialog box that appears, enter the telephone number of the MPR unit you wish to connect to (this number will be saved between program sessions). Click “OK” to attempt a remote modem connection to the MPR controller.


5. If you have a speaker on your modem you will hear the “handshaking” tones of the two modems. If the connection is successful, the “Logging into MPR9800” message will appear and the MprComm software will attempt tp download the status information from the MPR-9800. If you experience an ERROR message, you may click the “Hangup” button to disconnect the modem, or simply wait for the timeout period to expire and the software will disconnect automatically. If problems persist, it may be necessary to update your modem driver via the Windows Control Panel.
6. To disconnect the modem, use the "Hangup" button in the MprComm software’s main toolbar

NOTE:
After the communication settings are correct and saved, in the future you may simply click the “Connect” button on the toolbar to establish a modem connection. 

The MPR-9800 information levels
After the controller's information is downloaded, the screen will now show the “Status” level information.

To view the individual levels, use the toolbar buttons to select the various information levels (Memory, Factory, Install, Controls). See Screen Figures #3,9,10,11,12 and 13.

To change settings in levels “CONTROLS”, “INSTALL” and “FACTORY”, you must first “UNLOCK” the level (a “Security” screen will appear automatically the first time you attempt to open any of these screens). After the lock number is entered select “OK”. See Screen Fig. #5. THE COMBINATION LOCK NUMBERS FOR “CONTROL” AND “INSTALL” LEVELS ARE 00 00 00 BY DEFAULT, AND THE COMBINATION NUMBER FOR THE FACTORY LEVEL IS 1 2 3 BY DEFAULT. DO NOT CHANGE ANY CALIBRATION FACTORS IN THE “FACTORY” LEVEL UNLESS ABSOLUTELY NECESSARY! THIS “FACTORY” LEVEL NUMBER SHOULD BE USED ONLY TO ENTER THE DIALOUT TELEPHONE NUMBER (FOR THE AUTOMATIC CALL OUT ON ALARM FUNCTION), THE SITE NAME, OR THE SNMP ADRESS (FOR NETWORK ALARM SENDOUTS, IF ENABLED FOR YOUR HARDWARE)!

When the level desired is unlocked, you can change settings by using your mouse to click the up or down spinners next to each parameter. Note that you may hold down the Shift key while clicking the Up/Down spinner to adjust a parameter in increments of 10, or hold down the Control key to adjust in increments of 100. Also note that many fields allow direct keyboard entry of numeric values (click on the value you wish to change to highlight the field, then type the desired value). Once you change the setting, press Enter or click the on-screen “S” button to send the change to the MPR-9800 controller.

OTHER FUNCTIONS OF THE COMMUNICATIONS PROGRAM

Updating the data while you are connected to the controller
The Refresh button in the STATUS screen will only update the data in the Status screen!

AUTOMATIC MPR-9800 CALL OUT

Some modem-equipped MPR-9800 units are equipped with a feature which enables them to automatically call out and notify a host computer when an alarm condition occurs. ALARM CALL OUT MUST BE ENABLED VIA THE FACTORY SCREEN!

If the “Alarms” button does not appear in the Factory screen, your MPR-9800 unit may not support automatic callout functionality.

To answer incoming alarm calls, the MprComm software must be in “AUTO-ANSWER MODE”- select under “Tools” menu. Leave in “Auto-Answer Mode” when unattended!

The downloaded information will appear as an alarm report screen describing the fault condition. This screen will have a red background.
TESTING OF MPRCOMM:

To test MPRCOMM, follow all of the procedures above using the Local connect. To test the remote call-up, follow the Dial Remote procedure. 

The Min/Max memory function of the MPR-9800 software may be tested by “fooling” the MPR-9800 into thinking that a change of day has occurred. 

1. In the Control screen, change the current time to 23:59:55, and allow the controller’s time to change to the next day (this will occur within 5 seconds time). Repeat this for X number of days and re-download the Min/Max data using MprComm (data is contained in the “Memory” screen). Access the Memory level and print if desired.

To exit the program, Select the File menu and select Exit or click the “X” button in the upper right corner of the program screen.

COMMUNICATION SOFTWARE FUNCTIONALITY AND WINDOW DESCRIPTIONS
Upon booting the program, the window will appear as in figure #1. 

You may select type of connection to attempt via the “Options” screen (accessed under the “Tools” menu). Direct Cable Connection is used for a local connection to the RS232 port via a modem cable, Modem Connection is used for a remote connection using your PC’s modem and telephone line. The “Network” option accommodates TCP/IP connections via LAN (Local-Area Network) or internet. 
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Figure #1

PULL DOWN MENUS
Figure #2 shows the “File” pull down menu;

Manage Maps – Select this option add new map images to the MprComm software, or to select a previously-added map image for display. See the “Installing a new map” section below for more information.

Display Log File - This command allows you to view previously saved log data. This command will only open up MPRCOMM data files. This feature is currently supported only for MPR-9400 units which are equipped with data-logging. Currently there are no versions of MPR-9800 which support data-logging.

Export Log File – Select this option to export a previously-saved Log file to a text file. The file is formatted as an ASCII tab-separated text file, suitable for import into many application such as Microsoft Excel or Access.

Save Unit Data – Select this option to save the current settings of the MPR controller. This is useful if you wish to backup your current settings, or if you wish to upload the same settings to another unit.

 

Upload Unit Data – Select this option to upload previously-saved unit settings to an MPR unit.

Export Unit Data File – Select this option to export a previously-saved unit data file as an ASCII text file.

Preview Report - This will display to the screen a report of the current MPR unit settings and real-time parameters (voltages, currents, accumulated amp-hours, etc)

Print Report - This command will print a hardcopy report of the current MPR unit settings and real-time parameters (voltages, currents, accumulated amp-hours, etc)

Exit - will exit the program.
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Screen Figure #2

Figure #3 shows the Toolbar buttons used to access the various screens when connected to an MPR-9800 controller;

Map - This selection will display a previously-installed site map. 

Status - This selection will access the Status window after the down loading process is finished. After the down loading process is finished,

The Status window will be the first window on the PC’s screen. See figure #9

Memory - This selection will access the 2 day Memory level. See figure #10

Controls - This selection will access the Controls level. See figure #11

Install - This selection will access the Install level. See figure #12

Factory - This selection will access the Factory level. See figure #13
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Screen Figure #3
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Screen Figure #4

Installing new maps in the MprComm software

Figure #4 show the “Manage Maps” screen. The MprComm software is not supplied with map images installed. It is necessary for the user to locate a suitable map image for their purposes. The map image should have an approximate aspect ratio (horizontal x vertical) of 5x3. If the aspect ratio is not exactly 5x3, this is not critical since the image will be stretched to fit the program window. For example, a 1024x768 will work well, even though it is closer to a 4x3 aspect ratio. The image should be saved in Windows Bitmap (.bmp) format (24-bit color). If the image is in another format, such as JPEG, it can be converted to a .bmp file using Windows Paint. Once a suitable image file is obtained, start up the MprComm program and select "Manage Maps" under the file menu. Click on "Add New Map" to add a new map. The new map is named "New Map" by default, but may be renamed by typing an appropriate name into the "Map Name" text box. To assign the bitmap file to the newly created map, click on the "..." button next to the File Path text box. This brings up a file selection dialog where you can select the map image (bitmap) file. Note that you may add multiple map images. If you have multiple map images added, select which map you would like to view using the Display Map button in the Manage Maps dialog box.
 

Once a new map has been added to the software, click the 'Map' button on the software's main toolbar to display the map. Once the map is displayed, you may add sites to the map by right-clicking the map image and selecting "Add New Site" from the popup menu. When the New Site icon appears on the map, right click it and select 'Properties' to edit the site. In the Properties dialog box, you may specify the Site Name, and the connection method to use to access the site. When you then double-click the site on the map, the software will attempt to connect to the site using the specified connection method. 

Figure #5 shows the “Security” screen. This screen will appear the first time you attempt to access the “Controls”, “Install”, or “Factory” screens

In order to change settings in the Controls, Install or Factory level you must first unlock the levels. When you unlock a level, the next screen will ask you to enter the correct combination number. Enter the number and click the unlock selection. After this is completed, you can now change settings in the level chosen.
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Screen Figure #5

Figure #7 - shows the “Tools” pull down menu;

Auto Answer - This command will place the software in Auto-Answer mode. Note that you must have a modem installed and properly configured in order for this option to function properly. The software will listen for incoming modem calls, and display an alarm screen if it receives an alarm callout from an MPR unit.

Connect – This will connect to an MPR unit, using the default communication method selected in the “Options” screen. Note that this is equivalent to clicking the “Connect” toolbar button.
Options – This brings up the “Options” dialog box (see figures #8A and #8B).

NEW for MPR-9800 PV version 5.00.00 and above: Ethernet (Local- and Wide-Area) communication capability has been added. See the addendum at the end of this documentation for details about configuring the Ethernet network parameters for the MPR-9800 unit.

Figure #8A - shows the ‘General’ tab of the Options screen (accessed from the ‘Tools’ dropdown menu). Use this tab to select the connection method that will be used when you click on the toolbar ‘Connect’ button.

Figure #8A - shows the ‘Communication’ tab of the Options screen (accessed from the ‘Tools’ dropdown menu). In the ‘Network’ box, you may type in an IP address and Port number to use when initiating network connections manually (via the ‘Connect’ button on the main toolbar). In the ‘Modem’ box, you may select the modem that you would like to use when making modem connections to the MPR-9400. If your modem does not appear in the drop-down box, make sure its driver is installed correctly in the Windows Control Panel. In the ‘Direct Cable’ box, select which COM port you would like to use to establish direct-cable connections to the MPR-9800. The ‘Enable Email Alarms’ checkbox will enable emailed alarm reports when the software receives an alarm report via modem. Note that the ‘Auto Answer’ function must be enabled in order to receive alarm reports via modem. See the section below entitled ‘Using the MprComm software to generate email alarm reports’ for more information regarding the alarm email function.

Using the MprComm software to generate email alarm reports – With MprComm software versions 1.1.4 and later, you may enable email alarm reports from the ‘Communication’ tab in the ‘Options’ screen (located under the ‘Tools’ dropdown menu). Note that this option is available only for modem-connected MPR-9800 units (network-connected MPR-9800 units also have the ability to generate emailed alarm reports; however, a separate SNMP management utility is utilized in conjunction with the SendMail utility in order to generate emails). If the ‘Enable Email Alarms’ option is activated, the MprComm software will send email alarm reports to designated email addresses when an alarm condition occurs. In order for this process to function correctly, the SendMail email client must be correctly configured. Upon installation of the MprComm software, a ‘SendMail’ folder will be created under the MprComm installation folder (the MprComm installation folder is usually ‘C:\MprComm’ if the program was installed to the default location). To configure the SendMail client, double-click the ‘mpr_SendMail.exe’ file in the SendMail folder to execute the SendMail program. The SendMail configuration screen (shown in figure #8d) should appear. In the ‘Email Host’ textbox, type in the name of the server that is used to send email from your network. The ‘Sender Name’ may be any name you choose (this appears in the ‘From’ field of the generated email). In the ‘Sender Email’ text box, type in the email address of the email account that will be used to send the outgoing alarm messages. The text contained in the ‘Subject’ text box will be used as the subject for the alarm email messages. To add a designated recipient, click on the ‘Add button’. You will need to supply the name and email address of the designated recipient. Click the ‘Alarm Messages’ button to view or edit the message content that will be generated when each designated alarm condition occurs. You may edit the messages if desired, or you may choose to accept the default messages for each alarm. When each of the above parameters have been correctly configured, you may close the SendMail program. The SendMail client is now configured and ready to send out email messages when the MprComm software receives an alarm report from a modem-connected MPR-9800 unit.
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Screen Figure #7
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Screen Figure #8A

[image: image8.png]Soner SRS Poin|

Network
Remote IP: [10.0.1.141

Remote Port: [4660
Modem

Standard 9600 bps Modem

Direct Cable

Connect Usin,

COM Port:

I” Enable Email Alarms ¥ Receive SNMP traps on port:[124

oK Cancel Apply





[image: image9.png]5 5DI MPR SendMail

Email Host [mai sdicommtzsh.conl

- Alam
Sender Name [557 Messages

Sender Emai [sgi@sdicommiech.com

Subiect [P Alam

Recipients
Name Ensi
|
Eat
Delete

Hovelp | | HoveDown Cancel oK





Screen Figure #8D

Figure #9 - shows the “Status” Window;
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Current Date / Time / Day-Of-Week (DOW)

These fields show the current date, time, and day-of-week. Note that these display fields are not continuously-updated in the MprComm software. To update the current information display on the Status screen, click the “Refresh” button.

Batt Volts

This field shows the current system Battery Voltage.

Batt AH

This field shows the estimated remaining Amp-Hours capacity of the Battery.

SOC%

This field shows the current State-Of-Charge (percentage) of the Battery. This is computed by determining the ratio of the current Batt AH (Battery Amp Hours remaining) vs the Batt AH Init (initial Amp-Hours capacity) specified in the Install screen.

Time Rem

This field shows the estimated Time Remaining that the battery can continue to supply current to the load. This is computed by dividing the Batt AH (remaining Battery Amp Hours capacity) by the current Load Amps.

Tcomp V

This field shows the magnitude of the temperature compensation voltage, based on the current system temperature.

VDisc, VRec

These fields show the computed High Voltage Disconnect voltages, scaled for the current mode (Float or Equalize), and adjusted for temperature compensation.

Amps fields: PV, Load, Batt, In, Out

These fields show the current (instantaneous) amps values:

PV: Amps supplied by the PV array(s)

Load: Amps delivered to the Load

Batt: Amps supplied by the Battery

In: Total Amps In collected from all PV sources

Out: Total Amps delivered to the load by the PV/Battery

Batt Temp, Unit Temp

These fields show the current Temperatures of the Battery and the MPR9800 Unit.

AH (Today) fields

These fields show the total Amp Hours accumulated by the various sources for the period of the current day (since midnight)

PV1, PV2 LEDs

These LEDs indicate whether PV1 and PV2 are presently connected to the Battery. The LED indicator lights green if the PV is presently connected to the battery

Load LED

This LED indicates whether the Load is presently connected to the system.

Gen LED

This LED indicates whether the Generator is currently active (supplying current to the battery)

HVA

This LED indicates whether the High Voltage Alarm is currently active.

LVA

This LED indicates whether the Low Voltage Alarm is currently active

EQU

This LED indicates whether the battery cell Equalization process is presently underway

Screen Figure #9

Figure #10 - shows the “Memory” Window;
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Screen Figure #10

Min / Max fields

These fields show the minimum and maximum values that have been recorded for the various Volts, Temperature, and Amps parameters. The fields listed under the ‘Today’ column are the minimums and maximums recorded today (since midnight). The fields listed under the ‘To Date’ column are the minimum and maximum values that have been recorded since the time of the last Min/Max Reset (See the Control screen for more information about resetting the Min/Max values)

Total Amp Hours fields

These fields show the total accumulated Amp Hours recorded by the MPR9800 unit, since the time of the last Amp Hours Reset (see the Control screen for more information about resetting the Amp Hours values)

Gen Hrs

This field shows the total number of hours that the generator has run, since the time of the last Gen Hours Reset (see the Control screen for more information about resetting the Gen Hours value)

Figure #11 - shows the “Controls” Window;
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Screen Figure #11

Current Date / Time

These fields allow the user set the current date and time.

DayOfWeek  and TimeCorr 
These fields allow the user to set the current Day of Week, as well as the Time Correction factor. The Time Correction factor is the number of seconds added (or subtracted) from the clock each night at midnight. This value can be used to compensate for drifting of the internal clock.

Load Timer, Mode and Time On   
These fields allow the user to set the time of day when the load will be enabled. If load switching is not desired, the load timer Mode may be set to ‘Disabled’.

Load Timer,  Time Off
These fields allows the user to set the time of day when Load 1 will be disabled.

213 Generator, Mode and VoltsOn / VoltsOff fields
These fields allow the user to set generator run mode (Gen-Off, Gen-On, Timed, or Current). Valid operating modes are:

Gen-Off: The generator is off at all times

Gen-On: The generator is on at all times

Timed: The generator will turn on if the battery voltage drops to the specified VoltsOn voltage, and turn off when the battery reaches the specified VoltsOff voltage. In addition, the generator will not run for longer than the HrMax (hours) specified in the Generator HrMax field.

Generator WaitDays and MaintMins
These fields set the Wait Days and Maint Minutes for the generator. If the generator has not run for a number of days equal to the specified WaitDays parameter, the generator will be turned on and run for a duration equal to the minutes specified in the MaintMins parameter. This is considered to be a maintenance run cycle, and the generator will be disconnected from the load for the duration of this run cycle.

Generator HrMax  
This window allows the user to set the maximum run hours for the generator and the battery cell equalization function. The generator will not run for a length of time greater than the duration (hours) specified by the HrMax parameter. The battery cell voltage equalization cycle will not run for greater than the duration (hours) specified by the EqHrMax parameter.

Download Log File
This button is used to download the history log data stored in the MPR9800 unit. See section 1.5 of this manual for more information regarding the various parameters that are stored in the MPR9800 history log.

Backup and Reset Today’s Data
This button allows the user to record today’s data (min/max data and amp hour totals) to non-volatile memory. This is normally done only just prior to a power-down of the MPR-9400 unit, when you don’t want to lose today’s data (today’s data is stored in RAM, which is erased if the unit is powered down).

Reset AmpHour Totals
This button allows the user to reset the recorded accumulated amp hour totals to zero. This affects the values displayed on level 0, windows 10-13.

Reset Min/Max Data 
This button allows the user to reset the stored Min/Max values. This affects the values displayed on level 1, windows 115-129.

Reset Gen Hours
This button allows the user to reset the accumulated generator hour totals.

Figure #12 - shows the “Install” Window;
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Screen Figure #12

HVD1 and HVD2, Mode,  Disconnect, and Reconnect settings
These fields are used to set the ARRAY 1 to Array 2  Disconnect and Reconnect voltages.  Each array input will disconnect at the Disconnect voltage and will Reconnect when the battery voltage drops to the Reconnect voltage setting. The user has the ability to set these HVD control channels to AUTO mode (factory setting), PV OFF and PV ON. PV OFF and PV ON will override the HVD settings.

LVD Mode,  Disconnect, and Reconnect
These are the set points for Low Voltage Disconnect relays #1 and #2. WINDOW 303 sets the Low Voltage disconnect and reconnect voltages for LVD #1. WINDOW 304 sets the Low Voltage disconnect and reconnect voltages for the LVD #2. The user has the ability to set these LVD control channels to AUTO mode (factory setting), LD OFF and LD ON. LD OFF and LD ON will override the LVD settings.

LVD Delay  Seconds 
This field allows the user to set the number of seconds which will elapse between the time that a Low-Voltage Disconnect condition occurs, and the time when the LVD relay contacts close. This prevents the load from being disconnected during brief voltage dropouts such as those caused when high-current equipment switches on.

HVA and LVA, VoltsOn and VoltsOff

These fields are used to set the alarm voltages and reset voltages for the High Voltage Alarm and Low Voltage Alarm.

Equalize Mode 
This field allows the user to select the charge mode. Valid settings are “Normal” (Float) and “Equalize”. The Equalize function raises the charge voltage to the batteries for a period of time in order to equalize the cell-to-cell voltages of the battery bank. See Level 2, Windows 5b, 5c, and 5d for more information regarding the equalize function.

EQU Days  
This field allows the user to set the automatic equalization cycle days, and the time-of-day when the automatic equalization will commence. Equalization will occur (beginning at the specified time of day) when the specified number of days have elapsed since the last cell equalization cycle.

EQU Max Hrs
This window allows the user to set the maximum number of hours that the equalization cycle may run.

EQU Vboost  and StopV
These fields allow the user to set the charge voltage boost level during the equalization cycle. The normal High Voltage Disconnect voltage level will be raised by the specified amount during the equalization cycle. The equalization cycle will terminate if the Battery Volts reaches the level specified by ‘StopV’.

Dark Protect Amps
Use this field to set the dark-protect amps. The Dark Protect function is designed to keep current from back-flowing into the PV panels during periods of darkness. The Dark Protect Amps sets the threshold (amps) for the Dark Protect function. When the PV amps falls below the specified threshold, the array is disconnected for a period of minutes specified in the Dark Protect Minutes field

Dark Protect Minutes

Use this window to set the dark-protect minutes. See the Dark Protect Amps field for more information.

Batt AH Init

Use this field to set the number of amp hours of battery capacity. This number reflects the maximum amp hour capacity of the batteries assuming the batteries are fully charged.

Batt Eff
Use this field to set the efficiency of the batteries. This parameter is usually set to around 90%

Tcomp: (mV/cell/°C)

This field allows the user to set the Temperature Compensation value. This value affects the computed High-Voltage and Low-Voltage Disconnect set points.

Tcomp High and Tcomp Low 
These fields are used to set the temperature range over which the Temperature-Compensation algorithm is applied. The Temperature Compensation adjustment is only in effect if the unit temperature falls in the range between the Tcomp Low and the Tcomp High.

Charge Mode

Use this field to set the charging mode. Valid settings are EBBM and Voltage.

Alarm Delay Seconds

This field allows the user to set the number of seconds which will elapse between the time that an alarm condition occurs, and the time when the alarm signal is asserted.

Figure #13 - shows the “Factory” Window;
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Screen Figure #13

Unit Serial Number 
This field shows the serial number of the unit. Though this number may be changed, it is not recommended that you do so.

Firmware Version 
These fields display the unit type (MPR9800) and the internal firmware version of the MPR9800 unit.

Batt Cal and Offset 
This variable sets the battery voltage measurement gain (Cal) calibration and Offset (zero). 

Load  Cal, Zero, and Shunt values
These variables set the Load amps calibration factors for gain (Cal) and offset (Zero).  The installed Load current measurement Shunt value (amperes per 50 mV output) is programmable from 5 to 995 Amps.
Load  Cal, Zero, and Shunt values
These variables set the PV amps calibration factors for gain (Cal) and offset (Zero).  The installed PV current measurement Shunt value (amperes per 50 mV output) is programmable from 5 to 1275 amps.
Bat Temp  Cal

This variable sets the battery temperature sensor’s metering calibration factor.

Unit Temp Cal
This variable sets the MPR-9800 Unit temperature sensor’s metering calibration factor.

SNMP Version
This variable sets the communication version used by the SNMP interface to send alarm notifications over the Local-Area- or Wide-Area network. Valid options are V1 (version 1), V2C (version 2C), and Inform.

SNMP Address
This variable sets the IP Address used by the SNMP interface to send alarm notifications over the Local-Area- or Wide-Area network. Alarm notifications originating from the MPR9800 will be directed to the monitoring PC residing at the specified IP address.

Site Name 
This field allows the user to program a custom Site Name for the MPR9800 unit. Any text string up to 40 characters in length may be used.
Modem Init String 
This field allows reprogramming of the text string used to initialize the MPR9800’s internal modem for alarm callouts. This string is set at the factory and usually does not require modification. This field applies only to modem-equipped MPR9800 units.
Dialout Telephone Number 
This field allows programming of the dialout phone number used by the MPR9800 to send alarm notifications via modem. This field applies only to modem-equipped MPR9800 units.
Vnom 
This window allows the user to set the nominal voltage of the system. This is usually 12, 24, or 48.
Data Logging: Minutes

Use this field to set the interval (minutes) between samples for the data logging (on MPR units equipped for data logging).

2nd Comm Interface
For units with Modem or Ethernet interfaces, this window allows the user to set the type of the 2nd communication interface.

Figure #15 - shows the “Log” Window. This window will appear after downloading a Log file from an MPR9800 unit. You may also bring up this window at any time to view previous Log files stored on the hard drive of your PC. To view a previously-stored Log file, use the “Display Log File” menu option (located in the “File” menu of the MprComm software). Note that not all MPR9800 units support the Data Logging function. 

When the Log window is displayed, you may click the “Graphs” button to view the Log information in graphical format (See Figure #16).
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Screen Figure #14

Figure #15 - shows the “Graph” Window;
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Screen Figure #15

Global parameter upload

The MprComm software is capable of uploading specified parameters globally to any or all MPR9800 units defined as sites on the Map display. To use this function, select ‘Global Parameter Upload’ under the MprComm File menu. In order to add entries to the list of parameters to be uploaded, first establish a connection to any of the MPR9800 units on the network. Once a connection to an MPR9800 unit is established, click on the ‘Capture Parameters’ button on the Global Parameter Upload screen. Now any parameter values that you change in any of the parameter screens (Control, Install, and Factory screens) will be recorded into the Global Upload Parameters list. Figure #16 shows the Global Parameter Upload screen with three parameters selected to upload.
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Figure #16
When you are finished selecting the parameters to upload, click on the ‘Sites’ tab to display a list of all MPR9800 sites currently defined on the Map screen (or on any of the Map screens, if you have multiple Maps defined). In the ‘Sites’ tab of the Global Parameter Upload screen, place a checkmark next to any of the sites that are to receive the specified parameters. Note that the connection parameters for each site (network IP address or modem phone number) are specified in the Site Properties window for each site (right-click the site on the Map to access the Site Properties screen). When you have selected the sites to receive the upload information, click the ‘Upload’ button on the Global Parameters Upload screen to begin the upload cycle. Note you must disconnect from the current MPR9800 unit before the Upload cycle can begin. When the Upload cycle completes, a Results screen will appear detailing the success or failure of each upload attempt.

CONFIGURING A NEW MPR-9800 ETHERNET BOARD:
A knowledgeable network administrator should be present during this procedure!

For the purposes of this procedure, you will need to have a MPR unit connected to your LAN (Local Area Network) via a straight-through wired 10-base-T cable, or connected directly to your PC’s network card via a crossover-wired cable. In many cases, it is simplest to use a laptop computer and a crossover-wired cable to connect directly to the MPR ethernet board to be programmed. In this way, any firewalls that may be in place in the Local Area Network environment are bypassed during initial setup of the board.
1. Execute the supplied “Monitor.exe” program from your MprComm software installation folder (Usually C:\MprComm). You should see a screen similar to the following:
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2. The MPR network interface card(s) detected on the local area network are listed in green text in the list box which appears in the Monitor.exe program display. If no MPR units are detected on the local area network, check to verify that you are using the proper type of cable for your network connection, and make sure that you do not have a firewall in place which may be blocking local broadcast traffic. You may need to reconfigure your firewall to allow “broadcast packets” (packets sent to IP address 255.255.255.255); or if you are experiencing difficulty, you may wish to temporarily disable your network firewall.

3. Select an MPR unit by left-clicking on its IP Address in the list. Once a unit is selected, you may configure its communication parameters by clicking the “Config” button. The following dialog will appear:
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Type in the desired IP address, Gateway, and Subnet Mask to configure the MPR controller (you may need to contact your network administrator if you are unsure what to enter for these values). Leave the User ID set to “admin” and the password blank.

4. To prepare to connect to the MPR for the first time via the network interface, you will need to verify that the MprComm software is properly configured for network access. Under the “Options” menu, select “Settings”. A settings dialog will appear. Select the “Network” tab to configure the MprComm software network settings.
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In the “Remote IP” text box, type the IP address that you assigned to the MPR unit. As of this writing, the “Remote Port” should always be set to 4660. Click “OK” to save your changes. You will need to restart the MprComm program for the changes to take effect.

OPTIONAL REMOTE COMMUNICATION HARDWARE

DIAL-UP MODEM/ISOLATION CARD 

P/N ACM-60001-00
FEATURES:

1. Compatible with MPR-9400 and MPR-9800

2. Communicates via analog telephone connection 

3. The ACM-60001-00 is equipped with an isolated power supply to accomplish the needed PCB power isolation, Viso & Giso.

4. The ACM-60001-00 is equipped with an RS232 chip coupled with an opto isolator to accomplish the communications isolation.

5. The ACM-60001-00 has the ability to be equipped with a 56K modem Modem with the isolated DB9 RS232 connection. OR without the Modem.

6. A program jumper selects the method of communication, either by RS232 OR Modem. 

7. Compatible with MPR-9400 and MPR-9800

2. GSM MODEM 

P/N MPR-GSM/F1 - Operates at  900/1800 Mhz.

P/N MPR-GSM/F2 - Operates at  850/1900 Mhz.

FEATURES:

1. Compatible with MPR-9400 and MPR-9800

2. Communicates via GSM protocols 

3. ETHERNET
P/N NE 9000-01

FEATURES:

1. Compatible with MPR-9400 and MPR-9800

2. Communicates via LAN OR WAN TCP/IP protocol

3. Allows the MPRs’ to send out SNMP alarm traps

4. Programmed at 10-Base-T

5. Isolated RS232 port

6. MPR’s automatically polls both RS232 port and Ethernet cards’ port
10 
SPECIFICATIONS

Specifications are provided in Table 1.

Operational Specifications

Table 1. Specifications
	Nominal Voltage:
	12V
	24V
	48V

	
	
	
	

	Max. Array Input Voltage:
	24V
	48V
	96V

	
	
	
	

	Max. Array Input Current:
	
	
	

	35A Model
	28A
	28A
	28A

	60A Model
	48A
	48A
	48A

	120A Model
	96A
	96A
	96A

	200A model
	160A
	160A
	160A

	
	
	
	

	Max. Continuous Load Current:
	
	
	

	All Models
	48A
	48A
	48A

	
	
	
	

	Steeping Tolerances:
	±0.03V
	±0.06V
	±0.12V

	
	
	
	

	Controller Current Consumption (excluding relays):
	40 mA
	40 mA
	40 mA


Mechanical Specifications

Fiber Glass NEMA 4X enclosure Dimensions:

Overall dimensions: - 17 1/2" tall X 15 7/16" wide X 7 3/4" deep

NEMA 1 dimensions: - 17 " tall X 14 " wide X 6 1/2" deep

Weight with NEMA4X enclosure: 33 lbs (10.4kg)

Operating Temperatures:


All Models: -40°C to +85°C (-40°C to 55°C ambient)

Enclosure Rating:


All Models: NEMA 1 or NEMA 4X (IP-65)

Voltage Surge Suppression:


All Models: Metal Oxide Varistors/Transorbs/R-C circuits

Wire gauge capacity for terminals:


All Models:

Arrays:
AWG 2/0-14

Battery:
AWG 2/0-14

Loads:
AWG 2/0-14
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ABSTRACT

An amp-hour counting battery charge control algorithm has been defined and tested using the Digital Solar Technologies MPR-9400 microprocessor based photovoltaic hybrid charge controller.  This work included extensive laboratory and field testing of the charge algorithm on vented lead-antimony and valve regulated lead-acid batteries.  The test results have shown that with proper setup amp-hour counting charge control is more effective than conventional voltage regulated sub-array shedding in returning the lead-acid battery to a high state of charge.  

INTRODUCTION 

Batteries in stand-alone and PV hybrid systems are commonly subject to abusive conditions that are generally due to, 1) under charging in low resource periods, 2) excessive charging in high resource periods, and 3) inappropriate or ineffective charge control for the battery technology.  The individual or combined effects of resource changes, poor charge control, and the daily load changes can be potentially damaging to the battery.  Previously available PV charge controllers or charge control strategies such as on/off PV array shedding will generally provide the battery with sufficient charging current to complete the bulk charge phase which will return the battery to 80 to 95% state of charge (SOC) [1,2].  After the bulk charge phase, the taper or absorption charge phase is very important in preventing stratification, hard sulfation, and premature capacity loss.  If a regulation voltage of 2.35 to 2.40 vpc is used for charging vented lead-antimony batteries, then a 10 to 24-hr regulated voltage finish charge period is usually required.  The available time for battery finish charging in PV systems is generally much less than 10-hrs.  The short time at regulation voltage results in an incomplete finish charge phase which consistently leaves the battery in an under charged condition.  If the regulation voltage for vented lead-antimony batteries is raised to 2.45 to 2.50 vpc and the reconnect voltage is raised to 2.28 to 2.30 vpc, then the finish charge time period can be significantly reduced.  With the higher regulation voltage, the battery may then be subject to excessive charge in high resource periods or low load periods.  The primary effect of the higher regulation voltage without amp-hour counting charge control on vented batteries is the dramatically increased watering requirements and increased erosion of active plate material.  For VRLA batteries the regulation voltage should be set to the manufacturers recommended value for a cycling application.  VRLA battery cycling regulation voltage is usually 2.35 or 2.40 vpc.  A reconnect voltage of 2.28 to 2.30 vpc is also very important to complete the finish charge period.  Very little can be done to accelerate the finish charge period for VRLA batteries because their charge acceptance is limited by the oxygen recombination cycle [3].  Higher regulation voltages will only accelerate dry-out.  That is why it is so very important to use constant voltage charging for the finish charge phase or simulate it with a well designed PV array shedding strategy.  

Based on energy calculations from the ìRAPS Design Manualî, published by the University of Cape Town South Africa and the authorís own calculations, battery energy costs for PV hybrid systems are estimated to be about $0.35 to $1.00/kWh over the life of the system [4,5].  As indicated above, any degradation in battery cycle-life can result in a significant system cost increase.  The potential cost benefit to stand-alone and PV hybrid systems is substantial if batteries meet their rated cycle-life.  

Amp-hour (Ah) counting charge control for PV hybrid battery charging systems is new to this application, but in the Battery Technical Manual from Battery Council International the cycle-life test procedure for deep cycle marine/RV batteries does use Ah counting as a means to ensure the battery is at a high SOC [6].  In this test procedure the maximum and minimum values for percent overcharge per cycle for vented and VRLA batteries are specified.  This along with regulation voltage insures complete battery recharge.  

Maximizing battery cycle-life requires using the manufacturers recommended regulation voltages, appropriate system design, effective charge control, and reaching the recommended overcharge in Ah when the battery receives a full recharge.  The excess Ah are a way to compensate for battery efficiency losses.  For most vented lead-antimony batteries the recommended Ah overcharge is between 120 and 130% of the discharged Ah.  VRLA batteries, which require more time at regulation voltage, are much more efficient and only require between 105 and 115% of the discharged Ah.  This paper will evaluate an Ah counting charge control algorithm for PV hybrid systems using a microprocessor based charge controller.


AH COUNTING CHARGE CONTROL

In a cooperative effort with Digital Solar Technologies a microprocessor based Ah counting charge control algorithm was defined and tested using the MPR-9400 PV hybrid charge controller.  The controller under test uses staged PV sub-array switching to achieve a taper charge for the battery finish charge period.  This charge control method can be a very effective charge strategy if properly setup.  It is typically used in medium to large PV hybrid systems.  

The new Ah counting charge control algorithm calculates battery Ah for each complete cycle.  A new cycle is started when the battery reaches the predetermined overcharge in Ah.  To implement the new Ah counting charge algorithm required four new input variables.  These variables are:

1)  BATAHINIT - Estimated battery capacity in Ah (Input by user),

2)  AHVRESET - Battery voltage when battery charging or high voltage disconnects (HVDís) are reactivated (Input by user),

3)  %ADD - Deficit or excess battery Ah at initial battery regulation voltage (Input by user - +or-25%),

4)  %OVER - Maximum overcharge above the daily Ah DOD (Input by user - 0 to 99%).

The Ah counting charge control algorithm opens the high voltage disconnect relays (HVD 1 and 2) when the specified %OVER plus %ADD Ah are charged into the battery.  The %OVER and %ADD Ah begin counting when the first HVD is reached.  Before the specified overcharge is reached, HVD 1 and 2 will operate as indicated by the preset disconnect and reconnect voltages.  The %OVER value is defined in equation 1.

((Ah chr - Ah dischr) / Ah dischr) x 100

(1)

Ah calculations for battery SOC and %ADD are based on the battery BATAHINIT capacity input by the user.  The displayed battery capacity in Ah and battery %SOC are reset to the BATAHINIT and 100% values respectively when the required overcharge is reached, or at 6 PM after an equalization charge.  If a load is turned on after charging is terminated, then the PV array will be reconnected when the battery reaches the preset AHVRESET voltage. 

SETUP AND INITIALIZATION

The MPR-9800 initialization for Ah counting charge control requires the user to identify the additional variables from the previous section.  The HVD 1 and 2 regulation voltage is generally available from the battery manufacturer and the reconnect voltage is usually set based on the sub-array shedding sequence and system design.  The %OVER, and BATAHINIT values are available from the battery manufacturer.  The %ADD parameter is very system dependent and can only be accurately identified by:

1) equalizing or boost charging the batteries, 

2) resetting BATAHINIT

3) running a standard cycle to regulation voltage,

4) recording the battery Ah when regulation voltage is reached, and

5) calculating %ADD by equation 2.

((BATAHINIT - Bat Ah at Vr) / BATAHINIT) x 100
(2)

In most cases the %ADD variable will be less than plus or minus 7%.  Test results have shown that as vented lead-antimony batteries age they will require adjusting the %ADD parameter from a positive number to less than ñ7%.  This is because of the increased gassing current resulting from antimony poisoning [7].  VRLA batteries typically will not experience significant changes in the %ADD value over their life because they generally have a stable end of charge current with very low gassing current.

PV SYSTEM SIMULATOR TEST RESULTS

The measured percent overcharge from three different stand-alone PV system simulations and a PV hybrid simulation has been obtained using an automated PV hybrid system tester from Team Specialty Products in Albuquerque.  This test-bed is capable of simulating two PV arrays or one PV array and one engine generator with two loads.  All system parameters are fully programmable and automated.  

Stand-Alone PV System Simulation

The stand-alone PV system test was conducted to evaluate Ah counting charge control using an array Ah to load Ah (C:L) ratio of 1.5, 1.75, and 2.0.  The simulation was configured to duplicate a typical stand-alone PV system using two 7-amp PV sub-arrays for battery charging.  The battery used in the system simulation was a GNB 12-5000X 400 Ah VRLA battery.  This battery is very similar to the GNB Absolyte IIP which is commonly used in larger stand-alone and PV hybrid systems.  A 1.5-amp continuous load and an adjustable nighttime load was used to establish the three different C:L ratios.  The new Ah counting charge control parameters for the MPR-9400 were input based on battery manufacturers specifications and the %ADD calculation from the above initialization cycle.  See Table 1 for a complete list of system parameters. 

In Fig. 1 are the test results, which show that the Ah counting charge control algorithm limits battery overcharge to within the 105 to 110% specified by GNB.  The voltage regulated charge period is also maintained between 1.9 and 2.3-hrs.  Using the same regulation voltages and system configuration without Ah counting charge control resulted in a battery overcharge range between 114 and 128%.  The voltage regulated charge period also varied between 3.9 and 5.0-hrs depending on the C:L ratio.  Without Ah counting charge control the only way to reduce overcharge is to lower regulation voltage or provide a two stage voltage regulated charge control.  The lower regulation voltage and two-stage charge control will decrease overcharge, but it will also increase the time required to charge the battery.  Voltage regulated charge control alone makes it very difficult to obtain optimum recharge due to weather and system design. 

 [image: image21.wmf]System

Value

Sub-Array 1

7-amp peak

Sub-Array 2

7-amp peak

Load 1

Continuous 1.5-amps

Load 2

19.3, 15.3, & 12.3-amps

Battery Size

400 Ah

Battery DOD

13.5, 12.0, & 10.5%

C:L Ratio

1.5, 1.75, & 2.0

MPR-9400

HVD-1

2.36 vpc Vr

2.30 vpc Vrr

HVD-2

2.35 vpc Vr

2.29 vpc Vrr

Temp. Comp.

(-5mv/C/cell)

BATAHINIT

400 Ah

AHVRESET

2.08 vpc

%ADD

1.9

%OVER

7


Table 1.  PV system simulator and charge controller setup parameters.
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PV Hybrid Simulation

The PV hybrid simulation was designed with one 7-amp PV array and an engine generator set to charge the battery at 20-amps once the 12.1 volt engine start voltage was reached.  The Charge Controller was programmed to terminate all charging when the required 107% overcharge was reached.  The system C:L ratio with one PV array was 0.62 and the %ADD input variable was still +1.9.  This system design resulted in the battery discharging to 12.1 volts during the fourth cycle.  The engine generator then returned the battery to full charge after the fourth cycle.

In Fig. 2 are the battery Ah and voltage plotted over a ten cycle period.  The measured overcharge values after the engine generator battery recharge were 110 and 111%.  The results indicate good reproducibility and they are close to the desired value of 107%.  This test is also useful in identifying the effects of different PV array C:L ratios and engine generator control strategies.  In this case the generator ran for a total of 3.5-hrs in bulk charge mode and 7.2-hrs in finish or taper charge mode for a total run time of 10.7-hrs returning 152 Ah back into the battery.  The end of charge current, which can be used to terminate charging, was measured at 3.9-amps.
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FIELD TEST RESULTS

In addition to the laboratory testing, the Ah counting charge control algorithm was used on two stand-alone PV systems with a 700 Ah Trojan L-16 vented lead-antimony battery and a 400 Ah GNB 12-5000X VRLA AGM battery.  These system tests represent each lead-acid battery technology and demonstrated that the Ah counting charge control algorithm will function well with each battery type even though they are significantly different in their recharge characteristics.  The most significant difference between the two battery types is the battery Ah at initial regulation voltage.  This charging difference is compensated for by the %ADD parameter in the MPR-9400. 

Ah Charge Control Using Trojan L-16 Batteries 

The stand-alone PV system using Trojan L-16 batteries is configured with three PV sub-arrays charging at a peak current of 16, 12, and 4-amps.  The two higher current sub-arrays are switched with the MPR-9400 charge controller and the 4-amp array is permanently connected to the battery bank.  The load is variable and is operational day or night.  Daily loads average 70 Ah/day but can range between 10 and 200 Ah/day.  The voltage setpoints on the MPR-9800 are set for staged sub-array switching at:

HVD-1 = 2.45 vpc Vr and 2.29 vpc Vrr, 

HVD-2 = 2.43 vpc Vr, and 2.27 vpc Vrr.

The Ah counting program parameters are set to:

BATAHINIT = 300 Ah

AHVRESET = 2.06 vpc

%ADD = -11.7

%OVER = 30

%OVER (0.30x70) + %ADD = -14.1 Ah

In Fig. 3 are the Ah overcharged and the respective percentage overcharge for a 15-day period.  The results indicate that the Ah overcharged are between 15 and 59 Ah with an average of 31 Ah.  The percent overcharge range is between 128 and 196% with an average of 153%.  These values are much larger and have a much wider range than would normally be seen in laboratory testing on new batteries.  These batteries are 5-yrs old, and as a result of normal aging processes, have experienced an increase in their gassing currents.  The higher gassing current requires more time for the battery to get to regulation voltage.  This results in a necessary but greater than normal overcharge.  Without Ah counting charge control, the Ah overcharged would be greater resulting in increased water loss and maintenance.
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Ah Charge Control Using GNB 12-5000X Batteries

A second stand-alone PV system using GNB 12-5000X VRLA AGM batteries is configured with two PV sub-arrays charging at a peak current of 7-amps each.  The two sub-arrays are switched with the MPR-9400 charge controller in a staged manner to simulate a taper finish charge.  The load is continuous and averaged 1.1-amps for a total of 26 Ah/day.  The voltage setpoints on the MPR-9800 were set for staged sub-array switching at:

HVD-1 = 2.36 vpc Vr and 2.30 vpc Vrr, 

HVD-2 = 2.35 vpc Vr, and 2.29 vpc Vrr.

The Ah counting program parameters are set to:

BATAHINIT = 250 Ah

AHVRESET = 2.04 vpc

%ADD = +3.5

%OVER = 10

%OVER (0.10x26) + %ADD = 11.3 Ah

In Fig. 4 are the Ah overcharged and the respective percentage overcharge for an 11-day period.  The results indicate that the Ah overcharged are between 2.4 and 4.6 Ah with an average of 3.6 Ah.  The percent overcharge range is between 109 and 118% with an average of 114%.  These values are higher than the test results from the indoor system simulator and indicate that a slightly lower %ADD value may be used.  The data also shows that in an actual PV system Ah counting charge control will be slightly less stable due solar and weather variations.

SUMMARY

Test results using the MPR-9400 Ah counting charge algorithm have shown that in typical stand-alone and hybrid PV systems Ah counting can improve battery charging over conventional voltage regulated sub-array switching by recharging the battery as quickly as possible without excessive overcharge during high resource or low load periods.  Appropriate overcharge is necessary to compensate for battery efficiency losses, prevent electrolyte stratification, prevent hard sulfation, and minimize premature capacity loss.  Excessive overcharge will accelerate dry-out in VRLA batteries and increase maintenance requirements for flooded/vented batteries.  Therefor, maintaining appropriate overcharge levels can improve battery cycle-life, lower maintenance costs, and reduce PV system life-cycle costs.  
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If the controller is equiped with a RS232 to RJ11 adapter the pin designations are as follows

RS232 TO RJ11 - 6 PIN ADAPTER
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Fig. 1.  VRLA battery % overcharge with and without Ah counting charge control.





Fig. 2.  PV hybrid simulation using Ah counting charge control.





Fig. 3.  Stand-alone PV system using Ah counting charge control and vented Trojan L-16 battery.





Fig. 4.  Stand-alone PV system using Ah counting charge control and GNB 12-5000X VRLA AGM battery.








**IMPORTANT NOTICE**





Upon Initial powering of the MPR-9800, set the local time using the “COMM” Program. If any time drift (inaccuracy) is noted, you may also set the Time Correction factor in the Status screen of the Comm software. The Time Correction factor is the number of seconds added (or subtracted) from the MPR-9800 clock each night at midnight. Valid values for the Time Correction factor range from –127 to 127.





**Important Notice **





The National Electrical Code and UL states that PV array continuous current can not be more than 80% of the rating of the controller or overcurrent device.





Please take this into account when ordering.








� EMBED AutoCAD.Drawing.14  ���





� EMBED AutoCAD.Drawing.14  ���








SCREEN FIG. #1





SCREEN FIG. #1


















































_1009887792.dwg

_1078319979.doc


PIN NUMBERS







1







2







3







4







5







6







PIN NUMBER & CONNECTION 







1. NO CONNECTION 







2. NO CONNECTION 







3. TRANSMIT 







4. RECEIVE 







5. BATTERY NEGATIVE 







6. NO CONNECTION












_1009885308.dwg

